AI-WB2-12F-KIT DEVELOPMENT BOARD
TUTORIAL (FOR WINDOWS USERS)

OVERVIEW

The Ai-WB2-12F Development Board is one of the latest modules of the
Ai-WB2 series developed by Shenzhen Ai-Thinker Technology Co., Ltd. It
uses Buffalo Lab’s BL602 IoT chip as the core processor, which supports Wi-
Fi 802.11b/g/n and BLE 5.0 protocol. Therefore, this module can be widely
used in mobile devices, wearable electronic devices, smart home, and many
other fields.
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PREREQUISITES

Windows 8.1 or newer, with appropriate environment variables set (details
in the next step).

MSYS2.

A tool for UART communication, such as Termite.

Eclipse IDE for Embedded C/C++ Developers.

Software Development Kit for Ai-WB2 Series.



https://msys2.org/
https://compuphase.com/software_termite.htm
https://www.eclipse.org/
https://drive.google.com/file/d/1CpdKCQ5eNje8mF5J-GvGqPW6yEQZwnUc

If you have already met all requirements, feel free to skip the rest of these steps
below.

SETTING ENVIRONMENT VARIABLES

o Press Win + R, in the text box type control panel:

I Run >

=7 Typethe name of a program, folder, document, or Internet
= rescurce, and Windows will open it for you,

Open: control panel o

Ok Cancel Browse...

o Type env in the search box, and choose Edit the system environment
variables. Click Yes if a prompt screen appears. The System Properties
window will open after that, click Environment variables... at the bottom.

BE env - Control Panel

&« v 4~ BE > Control Panel

Q System
- i i jables for vour account
G Edit the system environment variables '

o Search Windows Help and Support for "env"




User Account Control

Do you want to allow this app to make
changes to your device?

g Advanced System Settings

Verified publisher: Microsoft Windows

IR |

System Properties >

Computer Name  Hardware Advanced  System Protection  Femote

You must be logged on as an Administrator to make most of these changes.

Performance

Visual effects, processor scheduling, memany usage, and virtual memory

Iser Profiles
Desktop settings related to your signdn

Settings...

Startup and Recovery
System startup, system failure, and debugging information

Settings...

Ervironment Variables ...

QK Cancel Apply




o You can see two regions, User variables for {your computer username, and
System variables. On User variables field, click New..., then type
MSYS2 PATH_TYPE for Variable name, and inherit for Variable value.
Click OK when done.

Environment Variables X

User variables for MakerL AR

Variable Value

OneDrive ChUsersiMakerl AB\OneDrive

OnelriveConsumer ChUsers\Makerl ABNOneDrive

Path ChUsers\MakerLAB\AppData\ Local\Microsoft\Windows&pps;: Chl...
Q5Ys_ROCOTDIR ChintelFPGA_lite\18. 1 quartus\sopc_builderibin

TEMP ChlUsers\MakerLAB AppDatatLocal\Termnp

TMP Ch\Users\MakerL AB\AppData\Local\Temp

Systern variables

Delete

Editl“

Variable Value

ComSpec ChAWindows\system32iomd.exe

DriverData ChAWindows\ System32\Drivers\ DriverData
MNUMBER_OF_PROCESSORS 12

Qs Windows_MNT

Path Ch\Program Files\Python310Scripts's C\Program Files\Python3100,...
PATHEXT LOM;.EXE; BAT,. CMD; VBS; VBE; 5, J5E; WSF, WSH; . MSCLPY; PYW
PROCESS0OR ARCHITECTURE  AMDE4

Edit... Delete

QK Cancel




Mew User Variable

Variable name:

| MSYS2_PATH_TYPE

Variable value: | inherit

Browse Directory... Browse File... Cancel
Ervironment Yanables

Uzer variables for MakerL AB

Variable Value 2
CrlLrb fl-l!:‘-

MSY52_PATH_TYPE

“OifeBrive Cisershialer AR OneDrve _“-———j
OnelriveConsumer ChUsers\Makerl ABNOneDrive
Path ChUsers\MakerLAB\AppData\ Local\Microsoft\Windows&pps;: Chl...
Q5YS_ROOTDIR ChintelFPGA_lite\18. 1 quartus\sopc_builderibin
TEMP ChUsersiMakerl ABVAppData\Local\ Ternp g

MNew... Edit... Delete

Systemn wvariables
Variable Value &
Comb5pec ChAWindows\system32icmd.exe
DriverData Ch\Windows\Systern 32\ Drivers\ DriverData
MUMBER_OF_PROCESSORS 12
Qs Windows_MNT
Path C:\Program Files\Python310Scripts'y Ch\Program Files\Python3100;...
PATHEXT LOM;:EXE; BAT, . CMD: VBS, VBE; J5:. JSE WSFWSH: . MSC PY: PYW
PROCESSOR ARCHITECTURE ~ AMDE4 N

Mew... Edit... Delete

] Cancel




o Next, on System variables, choose Path, and click Edit...:

Environment Vanables

User variables for MakerL AB

Variable Value
HPPAuseHwCntrs false
MSYS2_PATH_TYPE inherit
OneDrive ChUsersiMakerl AB\OneDrive
OneDriveConsurmer ChUsers\Makerl ABNOneDrive
Path Ch\Users\MakerLAB\AppDatat Local\Microsoft\WindowsApps;: ChUL..
Q5YS_ROOTDIR ChintelFPGA_lite\ 18,1 quartus\sopc_builderibin
TEMP ChUsers\Makerl ABVAppData\Local\Ternp
Mew... Edit... Delete
Systemn variables

Variable Value
Comb5pec ChWindows\system32iomd.exe
DriverData Ch\Windows\Systern 32\ Drivers\ DriverData
MUMBER_OF_PROCESSORS 12
as Windows_MNT

C:\Program Files\Python310h5cripts'; C:\Program Files\Python3104,...
PATHEXT LCOM: EXE; BAT:.CMD; VBS; VBE: J5: J5E WSF.WSH, MSCLPY: . PYW
PROCESSOR ARCHITECTURE — AMDE4

Mew... Delete

QK Cancel




o Click New, then Browse..., and select the \toolchain\riscv\MSYS\bin folder
from the downloaded SDK. Then click OK to save the directory, and OK
again to go back to the environment variables window.

Edit environment variable x
Ch\Program Files\Python3100Scriptsh,
C\Program Files\Python3 104 :
CAWindows\system32 Edit
Ch\Windows
CAWindows'\System32\Wbem Browse...

CAWindows\System32\WindowsPowerShell'w1.0y i
CAWindows\System32\OpenSSH\
Ch\Program Files\NVIDIA Corporation\NVIDIA NvDLISR

CA\Program Files (x86\NVIDIA Corporation'\Phys¥\Common
C\Program Files\dotneth, Move Up
C\Program Files (x236\HP\HP Performance Advisor

Move Down
Edit text...
OK Cancel
Edit environment variable x
Ch\Program Files\Python3100Scriptsh, Mew
C\Program Files\Python3 104
CAWindows\system32 Edit
Ch\Windows
CAWindows'\System32\Wbem
CAWindows\System32\WindowsPowerShell'w1.0y
CAWindows\System32\OpenSSHY Delete

Ch\Program Files\NVIDIA Corporation\NVIDIA NvDLISR

CA\Program Files (x86\NVIDIA Corporation'\Phys¥\Common
C\Program Files\dotneth, Move Up
C\Program Files (x236\HP\HP Performance Advisor

I I | o< Oz

Ediit text...




Browse For Folder *

hd Ai-Thinker-WEB2 ™
applications
components

make_scripts_riscv

v toolchain
v riscw
Darwin
Linuz
W MSYS
bin w
Folder: | bin
Make Mew Folder Cancel
Edit environment variable *

CA\Program Files\Python3100\5criptsh, New
C\Program Files\Python3 104
CAWindows\system32 Edit
Ch\Windows
ChAWindows\System32\Whem Browse...
Ch\Windows\Systern32\WindowsPowerShellw1.0y
CAWindows\Systern324OpensSHY Delete

CA\Program Files\NVIDIA Corporation\NVIDIA NvDLISR

CA\Program Files (x88)\NVIDIA Corporation'\Physi\Commaon
C\Program Files\dotnet', Move Up
C\Program Files (x86)\HPVHP Performance Advisor

e ——

DAAI-Thinker-WB2\toolchain\riscv\MSYS\bin

Mowve Down

Edit text...

o Double check the newly added user variable and system path. When done,
click OK two more times to save all changes and close the Environment
Variables and System Properties window.




INSTALLING MSYS2 AND MAKE

o Go to https://msys2.org. Scroll down and click the download link under
Installation section.

1. Download the installer:

o Wait for the download to finish, then run the installation.

MSYS2 Setup

Setup - MSYS2
Setup - MSYS2
Welcome to the MSYS2 Setup.
Installation Folder
Start Menu shortcuts

Installing

Finished

o Click Next. Specify where MSYS2 will be installed, default is C:\msys64.

®
« MSYS2 Setup
Installation Folder
Setup - MSY52
P Please spedfy the directory where M5Y52 will be installed.
Installation Folder |C:'u'nsy564{ Browse. ..

Start Menu shortcuts
Installing

Finished


https://msys2.org/

o Next. Leave this part unchanged.

<« MSYS2 Setup

Setup - M5YS52
Installation Folder
Start Menu shortcuts
Installing

Finished

Start Menu shortcuts

Select the Start Menu in which you would like to create the program's shortcuts. You can also enter a name
to create a new directory.

msvsal

Accessibility ~
Accessories

Administrative Tools

Crocodile Clips

Eclipse

Internet Download Manager

Maintenance v

o Next. Wait for installation to complete.

<« MSYS2 Setup

Setup - M5YS2
Installation Folder
Start Menu shortcuts
Installing

Finished

<« MSYS2 Setup

Setup - M5YS2
Installation Folder
Start Menu shortcuts
Installing

Finished

Installing MSYS2

. 7%

Unpacking components...

Show Details

Install Cancel

Creating Maintenance Tool

e
Installation finished!
All components installed.

Hide Details
Frererary
A
€[He[21<[3]
Done
Writing maintenance tool.
Installation finished! v

Cancel



o Next. Leave the checkbox checked, and click Finish to launch MSY S2.

M5YS2 Setup

Completing the MSYS2 Setup
Setup - MSYS2
HP Click Finish to exit the MSYS2 Wizard.
Installation Folder Run MSYS2 now,
Start Menu shortcuts

Installing

Finished

o A black terminal window will appear:




o Inside the terminal, type pacman -S make:

M -

§ pacman -5 make|

o Press Enter, then type y and Enter again when prompted:

M -

% pacman -5 make

resolving dependencies...

Tooking for conflicting packages...
Packages (1) make

Total Download Size: 0.49 MiB
Total Installed Size: 1.61 MiB

:: Proceed with installation? [Y/n]




Packages (1) mak

Total Download
Total Installed Size:

Proceed with installation? [¥/n] v
Retrieving

e

inning post-transaction ho

o You have successfully installed make. You may close this window now.

INSTALLING TERMITE

There are many programs that can transmit and receive UART signals.
In this tutorial, we will take a look at Termite, a Serial terminal by
CompuPhase.

o Go to https://compuphase.com/software_termite.htm, then scroll down and
click on the download link under Downloads & license.

Downloads & license

Termite 3.4 is copyrighted software that is free for personal and commercial use. You may use it and distribute it without limitations. You may however
not remove or conceal the copyright. There are no guarantees or warranties whatsoever; use it at your own risk.

The example plug-in filters are distributed under the zlib/libpng (open source) license.

‘ Termite version 3.4 - complete setupk332 KiB)
- g setup contains lermite and all plug-ins and documentation (but excluding the source code for these plug-ins). This setup is

provided to conveniently and quickly install Termite. (Note that Termite does not require installation, but it may just be convenient to do so.)



https://compuphase.com/software_termite.htm

o Wait for the download to finish, then run the installation.

g Termite Setup — .

Welcome to Termite Setup

About to install Termite 3.4 on your system.

http:/fwww . compuphase. com

o Next, shows the list of features that will be installed. Check/uncheck the
features you want/don’t want.

@ Termite Setup - x

Termite
version 3.4

Check the components you want to install and unchedk the components you don't want to
install. Click Mext to continue.

Select components to install: Core files |'required'] A DESICITIFItIOI"I
W " Position your mouse

Languages OvEr & COMPOnEnt ko
Hexadedmal View see jts description.
Highlight filter

Log file filter

Status LEDs filter

Time stamp filter
Function key macros
Auto-reply filter ~
=1 = 1 v e

Space required: 585.0KiB

Termite - 3.4




o Next, choose an install location, default is C:\Program Files (x86)\Termite.

g Terrnite Setup - >
Temmite Yy
version 3.4 *

Setup will install Termite in the following folder. To install in a different folder, didk Browse and
select another folder. Click Install to start the installation.

Destination Folder

| C:\Program Files (x86)\Termite| Browse...

Space reguired: 585.0KB
Space available: 171, 5GiE

Termite - 3.4

o Click Install, and wait for installation to complete.

ﬁ Termite Setup —

Temite

The installation has completed successfully.

Run Termite.

< Badk Cancel




o Leave Run Termite checkbox checked, but do not click Finish yet. Instead,
plug in your Ai-WB2-12F module now. If this is the first time you connect
the module to your computer, you will get this notification:

¥ Settings

Setting up a device
We're setting up 'USB Serial’.

o Wait for about a minute, then go to Control Panel again, find and open
Device Manager:

BE d - Control Panel

= v Control Panel

Devices and Printers
")’( !ﬂavice Manager )

View devices and printers

Change default printer

Scan a document or picture

Change device installation settings
Add a device

Advanced printer setup

o In the list of drivers, find Port (COM & LPT), expand it, you will see USB-
SERIAL CH340 (COMx), where x is a number assigned by your computer.
Note down this COMXx, which will be used quite often later.

" ﬁ Ports (COM 8 LPT)
ﬁ USB-SERIAL CH340 (COM4)



o You can now click Finish on the Termite installation window. Termite will
be launched shortly.

€D Termite 3.4 (by CompuPhase) - ¥

Disconnected - dick to connect ‘ Settings ' Clear About Close

Failed toinitialize the port.
Flease werify the COM port seftings.

o Click Settings, then change the following:
o Port to the previously noted COMXx.
o Baud rate to 115200, Ai-WB2-12F’s default.
o Transmitted text to Append CR-LF, for future convenience.
o Polling to 1 ms. Not required, but the faster, the better.

Serial port settings

Port configuration Transmitted text Options
Port () Append nothing [ ]stay on top
| .
i Append CR Quit on Escape
O App p
Baudrate 1152':”:' [ilipEnd [v] Autocomplete edit line
) @) Append CR-L Keep history
Data bits 8 e N
Icallechin [ ] Close port when inactive
Stop bits 1 > Received text Plug-ins
Parity mrs " Polling @ ms [] Auto Reply )
Max, lines |:| Function Keys
Flow control | none e Hex View
Font | default A o .
[ Jword wrap 11 AnEla e

User interface language | English (en) w | Cancel Ok




o Double check everything, and click OK. Termite should be initialized and
ready now, with COMx and baud rate displayed at the top left corner.

€D Termite 3.4 (by CompuPhase) — X

| COM4 115200 bps, 8M1, no handshake | | settings | | Clear About Close

Termite iz initialized and ready.
Twpe a string in the edit line (below) and press <Enter>
{orwait for the remote device to send data).

INSTALLING ECLIPSE

o Go to https://eclipse.org, and download the installer.

o (@ Editmy account £ Manage Cookies:

{ E C L I p S E Projects  Working Groups  Members More~ Q ~ .
F NDATION |

The Community for Open Innovation and
\ Collaborati_om.i. \

-

The Eclipse Foundation provides our global community of individuals and
organizations with a mature, scalable, and business-friendly environment
for open source software collaboration and innovation.



https://eclipse.org/

The Eclipse Installer 2023-03 R now includes a JRE for macOS, Windows

and Linux. OpenJDK Runtimes

by ADDPTIUN

A The Eclipse Temurin™ project provides high-quality, TCK
Get ECleSE IDE 2023-03 certified OpenJDK runtimes and associated technology for
Install your favorite desktop IDE packages. use across the Java™ ecosystem.

‘ Download x86_64
=)

ges | Need Help?

All downloads are provided under the terms and conditions of the Eclipse Foundation Software User Agreement unless otherwise
specified.

& Download

Download from: Japan - Japan Advanced Institute of Science and Technology (https)
File: eclipse-instjre-winé4.exe | SHA-512

== Select Another Mirror

o Run the installer. Scroll down and choose Eclipse IDE for Embedded
C/C++ Developers:

o | DONATE
eCIIpselnSta”er by Comph

type filter text

o L

Git client, XML Editor, Maven and Gradle integration ~

@ Eclipse IDE for Enterprise Java and Web Deve

Tools for developers working with Java and Web applications,
including a Java IDE, tools for JavaScript, TypeScript, JavaServer...

@ Eclipse IDE for C/C++ Developers
++

An IDE for C/C++ developers.

Eclipse IDE for Embedded C/C++ Developers

An IDE for Embedded C/C+ developers. Itincludes managed cross
build plug-ins (Arm and RISC-V) and debug plug-ins...




o Choose an Installation Folder. For Java 17+ VM, any version is fine. I
personally prefer the latest version.

eclipse

Eclipse IDE for Embedded C/C++ details
L++ Developers

An |DE for Embedded C/C++ developers.

Java 17+ VM =.0rg/justjfjres/17/updatessrelease/latest ¥ [l

JRE 20.0.1 - https://download.eclipse.orgfjustj/jres/20/upd
IRE 19.0.2 - httpsy//download.eclipse.org/justj/jres/19/upd
JRE 18.0.2.1 - https:/download.eclipse.orgfjustjfjres/18/up
' s://download.eclipse.org/just)/jr

Installation Folder

& create desktop shortcut

£ BACK

o Click Install, then click Accept Now when the User Agreement window
appears. Wait for installation to finish.

) Eclipse Installer - m] X
Eclipse Foundation Software User Agreement @
Applicable licenses will be discovered and prompted later in the installation process. h
Avoid such interruptions by accepting the licenses that govern Eclipse content now, mp
. . . ~

Eclipse Foundation Software User Agreement Versions
There are currently three versions of the Eclipse Foundation Software User Agreement. You may
review them and accept them now, or wait until you are prompted to review and accept them later.

+ Eclipse Foundation Software User Agreement Version 2.0

+ Eclipse Foundation Software User Agreement Version 1.1

+ Eclipse Foundation Software User Agreement Version 1.0
Version 2.0
Eclipse Foundation Software User Agreement
November 22, 2017
Usage Of Content
THE ECLIPSE FOUNDATION MAKES AVAILABLE SOFTWARE, DOCUMENTATION,
INFORMATION AND/OR OTHER MATERIALS FOR OPEN SOURCE PROJECTS
(COLLECTIVELY "CONTENT"). USE OF THE CONTENT IS GOVERNED BY THE TERMS
AND CONDITIONS OF THIS AGREEMENT AND/OR THE TERMS AND CONDITIONS OF
LICENSE AGREEMENTS OR NOTICES INDICATED OR REFERENCED BELOW. BY USING
THE CONTENT, YOU AGREE THAT YOUR USE OF THE CONTENT IS GOVERNED BY o
THIS AGREEMENT AND/OR THE TERMS AND CONDITIONS OF ANY APPLICABLE

—
| Accept Now [) Decide Later
—




o Installation complete. Click Launch to run Eclipse right away. The
Launcher window will appear.

Installation completed successfully.

Eclipse IDE for Embedded C/C++ Developers details
C An |DE for Embedded C/C++ developers.

Java 17+ VM psoffdownload.eclipse.org/justj/jres/20/updates/release/latest

Installation Folder ChUsersiMakerLAB\eclipselembedcpp-2023-03

f create start menu entry

& create desktop shortcut

> LAUNCH

show readme file
open in system explorer

keep installer

£ BACK



o Choose a workspace directory, default is
C:\Users|{your computer username}\eclipse-workspace. Then click
Launch.

= Eclipse IDE Launcher O

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and developrment artifacts.

Workspace; v ChUsers\MakerLAB eclipse-workspace ~ Browse...

[]Use this as the default and do not ask again




Starting Eclipse IDE

BRms 4 imin gl F o wre - E

@ Welcome >

- H
(' EC“pse Welcome to the Eclipse IDE for Embedded C/C++ Developers

A guided walk-through how to import an existing project Get an overview of the features

Review the IDE's most fiercely contested preferences Go through tutorials
Create a new Eclipse project for Embdedded C/C++ source code Try out the samples
Open the New item wizard Find out what is new

Checkout Eclipse projects hosted in a Git repository

Import existing Eclipse projects from the filesystem or archive
[ Always show Welcome at startup ¥




o After closing the Welcome screen, this will be your main work area:

-
F BETiRin Sl e W |

Bl Project Explorer

0 items selected

o We need to set up a few more things to get Eclipse ready. Go to Window ->
Preferences:

Project  Run Window  Help
o E Mew Window L E'; ‘# E@ m E '* " * * “
Editor ¥

Appearance

MNavigation

Preferences




o Under MCU, go to Global Build Tools Path. In Build tools folder, select
\msys64\usr\bin from where you installed MSYS2 earlier.

Global Build Tocls Path

The locatic
defined mor

Build to

o Also under MCU, go to Global RISC-V Toolchains Paths. In Toolchain
folder, select {SDK location}\toolchain\riscv\MSYS, and click Apply and
Close.

Global RISC-V Toolchains Paths

hains are installed. The values are stored within Eclipse. Unless redefined more

Toolchain folder: F 0 \ & Browse...

On macO5 use Shift+Cmd+" how the hidden folders while browsing the fil xpm uses a .content folder t e the binaries,

Apply

| Apply and Close Cancel

This wraps up our initial setup for Eclipse. You are now ready to create your
very first project.



YOUR FIRST PROJECT: BLINKING AN LED
o Go to File -> New -> Makefile Project with Existing Code:

ik e oS E

Alternatively, just click Create a new Makefile project in a directory
containing existing code at the top left corner. Either way will open the same
New Project window.

Help
- i IBEviniw &R e | E




o On the New Project window, set Existing Code Location to {where you
saved the SDK}\Ai-Thinker-WB2\applications\get-started\blink. Then give
your project a name, and set Toolchain for Indexer Settings to RISC-V Cross

GCC.

Import Existing Code

Create a new | in that same

Show only available toolchains that support this platform

o Click Finish. You will see the project folder being created to the left. You
may see a few errors and warnings under Problems, which you can safely
ignore for now.




o Right click the project folder, and click Properties (or simply select the
folder and press Alt + Enter).

Show In

Show in Local Terminal

[: 0 FI '_'r"

Source

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Build Targets
Index

Build Configurations

Profiling Tools

Run As

Debug As

Profile As

Restore from Local History...
Run C/C++ Code Analysis
Tearn

Compare With

Validate

Configure

Source

& Properties Alt+Enter




o Click on C/C++ Build. Under Builder Settings, uncheck Use default build
command, and type make in Build command. Under Behavior, empty the
Clean textbox, and change Build (Incremental build) to flash p=COMXx.
After clicking Apply and Close, Clean Project will compile the project, and
Build Project will both compile the project and download it to your Ai-
WB2-12F.

== Properties for blink

C/C++ Build

Configuration: |Default [ Active ] * | | Manage Configurations...

B Builder Settings # Behavior & Refre

build command
mand: make Variables...

ure build arguments in the Behavior tab.

. | | File system... | | Variables...

Apply

Apply and Close Cancel
== Properties for blink
C/C++ Build

Configuration: |Default [ Active ] * | | Manage Configurations...

gs ) Behavior| 4 Refre

ild arguments

st build error M Enable parallel build

@ Use custom build arguments

Build arguments:

nch automatic build preferes

flash p=COMA4 Variables...

Variables...

Apply

S
Apply and Close | Cancel




o Right click the project folder again, and click Clean Project.

Show In Alt+5hift+W »

Show in Local Terminal »

By Projec I8 Copy
B L

Delete

Source

Rename...
Import...
Export...

Build Project
Clean Project

Refresh

o Since this is the first time you compile the project, it will take around 6 to 8
minutes to finish. You can observe the progress in the Console at the bottom.

[l Properties




o You have successfully compiled your first project. To actually see this
project in action on your Ai-WB2-12F module, right click on the project
folder, and click Build Project.

Show In Alt+Shift+W >

Show in Local Terminal

Fia Proj I8 Copy Ctrl+C
E b

Delete Delete

Source

Rename...
Import...
Export...
Build Project
Clean Project

Refresh

o Since you have already compiled the project once, the progress is now much
faster, only taking a few seconds.

= B Conscle > [ Properties

nk]

Build Project: (20%)

o Put your hand on the EN button on the module, and press it as soon as the
console outputs Please Press Reset Key! (See picture below).

ads\Ai-Thinker-wWB2\tools\flash_tool\chips

} Build Project: (24%)



o Wait for a few more seconds. When the console output is the same as below,
you have successfully downloaded the project to your Ai-WB2-12F
module.

o However, you will not see the code immediately in action yet. Remember
Termite? Open it now, and press EN again. On your Ai-WB2-12F, you will
see a blue LED blinking on and off every second, and on 7ermite, you will
see a bunch of green text like below. Every time the blue LED turns on, the
module will also put Turning the LED ON! on the Termite screen, then
Turning the LED OFF! when the blue LED turns off.

€% Termite 3.4 (by CompuPhase) - s

[ COM7 115200 bps, 8M1, no handshake Settings About Close

Starting bI602 now....

Booting ARWE2 Modules..

RISC- Core Feature: R 32-ACF M
Build %ersion: release_hl_iot_sdk_1.6.38
Build Diate: May § 2023

Build Time: 11:43:53

blog init set power on level 2, 2, 2.

[IRG] Clearing and Disable all the pending IRG...

[1B][32mINFO (D)[hal_boot?.c: 251] [HAL] [BOOT2] Active Parition[0] consumed 536 Bytes[1B][0m

[TE][32mIMNFO (Mi[hal_boot2.c: 53] ======= F{Tabla_Config (@0x4200d168=======[1B][0m

[BI[3EZmINFD (D[hal_baot?.c: 54] magicCode 0x54504642; versian 0x0000; entryCrnt 7; age 0; cre32 I ZDF9AZE[TB][0m
[B][32mINFD (M[hal_baoot?.c: 59] id= type device activelndex  name Address[0] Address[1] Length[0] Length[1] age[1E][0m
[1B][32mINFO (0)[hal_boot2.c: 61][00] 00 il P 000010000 0x00028000 0x000:45000 0x00088000 O[1B][0m
[1B][3Z2mINFO (D)[hal_boot2.c: 61][01] 02 I mig 0x00170000 000000000 0=00032000 000000000 O[TB][Om
[1B][3ZmINFO (D)[hal_hoot?.c: 61][02] 03 0 media 0x00122000 0x00000000 0x00047000 0x00000000 O[1E][0m
[1B][32mINFO (D)[hal_boot?.c: 61][03] 04 il PShd 0x00129000 0x00000000 O0x00005000 0x00000000 O[1E][0m
il
il
il

i e I e e |

(
(
(
(
{
(
[1BI[EEZmINFO (M[hal_bootz.c: 61][04] 05 KEY 00111000 000000000 Ox00002000 Ox00000000 0[1E][0m
[1BI[EFZmINFO (D[hal_bootZ.c: 61][05] 06 DATA Dx007f3000 0x00000000 0x00005000 0x00000000 O[18][0m
[BI[EZmINFO (M[hal_bootz.c: B1][08] 07 O factory Ox001f3000 0x00000000 0x00007000 O0x00000000 O[1E][0m
{
{
(
(
(
(
(
{

[1B][32mIMNFO {0)[bl_flash.c: 363] ======= FlashCfg magiccode (20x42049:18=======[1B][0m
[1B][3Z2mINFO (D[hl_flash.c: 364] mid 0=5E[1E][0m

[1BI[32mINFO (D[bl_flash.c: 365] clkDelay 0x1[1E][0m

[1B][F2mINFO (D)[bl_flash.c: 366] clkinvert D1[1B][0m

[TBIEZmINFO (D[kl_flash.c: 367] sectar size 4K Bytes[18][0m

[EI[FEmINFD (Mkl_flash.c: 368] page size 2hEBytes[1B][0m

[1B][32mINFO (O)[bl_flash.c: 369] [1B][0rm

[1B][32mINFO (D)[hal _board.c:1279] [MAIN] [BOARD] [FLASH] addr from partition is 0018000, retis 0[1B][0m
[1B][3Z2mINFD (D)[hal_hoard.c:1287] [MAIN] [BOARD] [<IP] addr from partition is 23717000, retis O[18][0m
[O5] Starting aos_loop_proctask...

[O5] Starting OS Scheduler..
Turning the LED QNI
Turning the LED OFF
Turning the LED OMI
Turning the LED OFF

| «




Congratulation, you have successfully run your very first project on the Ai-
WB2-12F by Ai-Thinker. If you are curious about the code, you can expand
the project folder, then expand the blink folder inside. The main code will be

In main.c.

== eclipse-workspace - blink/blink/main.c - Eclipse IDE

File  Edit  Source  Refactor Mavigate  Search  Project  Run  Window  Help
' BB % A Rifin Sid N F € e ® L

Bl Project Explorer 3 = B B mainc

g.mk i ) uinta value

G ‘

®TaskCreate(blink_test, » NULL,

, NULL);




FEATURE TEST: WI-FI

o Let’s test one of Ai-WB2-12F’s main features: Wi-Fi connection. With

Eclipse still open, go to File -> New -> Makefile Project with Existing
Code, and choose \wifi\station in the get-started folder.

= Mew Project

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Mame
Existing Code Location

D:\Ai-Thinker-WE2\applications\wifi\station

Languages

MC MC+

Teelchain for Indexer Settings

<nonex>

GMNU Autotools Toolchain
RISC-V Cross GCC

Show only available toolchains that support this platform

Einish Cancel




o Unfortunately, build configurations must be set separately for each project.
To save time, you can copy previous configurations from the blink project.
Right click on the station project, then go to Build Configuration ->
Manage...

= eclipse-wo

File Edit Show In Alt+Shift+W * Run Window

‘. . ‘ Show in Local Terminal b B @
B Project Expl I8 Copy Ctrl+C
0]

g bink

Delete Delete

Source

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Project

Build Targets
Index
Build Cenfigurations b Set Active

Manage...

Profiling Tools
Run As : Build All
Debug As » Clean All

Profile As H Build Selected...

o Inthe Manage Configurations window, click New ...
== station: Manage Configurations

Configuration Description Status

Default Active

Mew... Rename...




o Give the new configuration a name, then in Copy settings from, choose
Import from projects, and choose blink > Default from the list.

= Create Mew Configuration

Mote: The configuration name will be used as a directory name in the file
system. Please ensure that it is valid for your platform.

Mame: station
Description:

Copy settings from

@ Existing configuration

O Import from projects | blink = Default

—o+ -=lected --
blink = Default
stativn -~ ceradlt

@ Import predefined

o Click OK, you will see the new configuration below Default. Select it and
click on Set Active.

== station: Manage Configurations

Configuration Description
Default

ctation

Set Active Mew... ) Rename...

Cancel




o The station project now has the same build configurations as the blink

project. You can double check that by going to Properties:

&= p

Bl C/C++ Build

figuration: |station [A

B Builder Settings
Builder
Builder type:

default build command

lidation

nand: make

Build location

Build directory:

C/C++ Build

figuration: |station [ Actin

Build settings

(o] ndard build arguments

top on first build error

kbench Build Beh
kbench build ty,

M Build on resourc ute build)

No Norkbench automatic build preference

Build {Incremental build)

Clean

Manage Configurations...

Variables...

Variables...

Cancel

Manage Configurati

M Enable parallel build
[ ]
[ ]
[ ]

Make build target:

Variable:

Variables...

ore Defaults Apply

Cancel



o Next, we need to adjust a few things in the main code. Expand the project,
then expand the station folder, and double click on main.c. Change your
ssid to your nearest Wi-Fi SSID, and your password to that Wi-Fi’s
password, or Il if the Wi-Fi is open.

== eclipse-workspace - station/station/main.c - Eclipse IDE
File  Edit Source  Refactor  Navigate Search Project  Run  Window H
‘m FW s A RiEifein | Sig & F ©
Ble ProjectExplorer % = B B mainc B *main.c
ESY

B [k

w g ctation
B include
main.c

uttalo.mik

wifi_conf_ t conf =

.country_code =




o Right click the project folder, and to save time, click Build Project directly,
no need to click Clean Project first. Once again, wait for the right time to
press EN on the Ai-WB2-12F module to download the code.

= eclipse-workspace - station/station/main.c - Eclipse IDE

File. Edit Source  Refactor Mawvigate  Search  Project  Run
‘m FWm % A BiPimie i o B
Bl ProjectExplorer % = B B *mainc X

BSY §

Mew

Go Into

Open in New Window
Show In Alt+Shift+W >

Show in Local Terminal

Co Py Ctrl+C

Delete Delete

Source

Rename...

Import...
Export...

Build Project
Clean Project fi_conf t conf =




o Open Termite and press EN again. If the provided SSID and password is
correct, the final lines of the output will look like this:

€D Termite 3.4 (by CompuPhase) — >

| COM7 115200 bps, 8M1, no handshake Settings Clear About Close

status_code 0 "
reason_code 0
connect result sm cannectind ak
bAAC AE:DEA38CEZ29
wf ik 0
ap_id=0
ch_ick= 0
qos 1
acm [
assoc_req_ie_len 58
assoc_rsp_ie_len 117
aid 0
band 0
center_freq 2437
width 0
center_freql 2437
center_freqd 0
=bd] Exiting connecting state
Shd] State Action ##connactingd —>2> ##dwifiConnected_ipObtainingidd
[ F][FF] Getting profile by indes, idx is &0
['F][=M] Entering wifiConnected_ipObtaining state
[WF][SM] DHCF Starting.. 0x420142584
[1E][FZ2mIMFO (3540 [main.c §2] [AFPF] [EVT] connected 394001 B][0m
IF:192.168.243.168
hAASK: 265.255.255.0
Gateway: 192.168.243.185
[lwip] netif status callback
IF 192168243168
hdk: 255.255.255.0
G 192.168.243.185
[WF[SM] Exiting wifiConnected_ipObtaining state
[WF][Sh] State Action ###wifiConnected_ipObtainingd#d —2> > #bwifiConnected PO
[WF][SM] Entering wifiConnected_IPOK state
[TE][F2mIMFO (4591 [main.c: 92] [APF] [EVT] GOT IP 4591 [1E][Orm
[E][F2mIMFO (4596 [main.c: 93] [5%'3] Memary leftis 158456 Bytes[1B][0m

| L+1]

EEPE PP EPEREREEEE

[/F]
[/F]

L N g B e |




o Otherwise, if either information is incorrect, then it will infinitely attempt
to reconnect every 2 seconds:

€D Termite 3.4 (by CompuPhase) — >
| COM7 115200 bps, 8M1, no handshake | Settings Clear About Close

[ E][F32mIMFC (607 [main.c. 72] [AFF] [EVT] Connecting BO7[1E][0m L]
===gtart sm_gef_bss_params===

bssid[0] = Oxdfft

bssid[1] = Oxdfft

bissid[2] = Oxdfft

search ssid = HshoplLTK

result ssid index =1

===agnd sm_get_hss_params===

— OFT mu_mgmi_ind is detected

ind ix 0xd207 2794, chan_chd is 0xd201 2213

connect failure, ssid = HshoplLTE, index =1

from sm_connect_ind to scanu_rm_exist_ssid

[F=] Connection Status

status_code B

reason_code 3

connect result; deauth by AF when connecting
hAC 94:B4:0F03:EE: 64

wif_ickx 0

ap_idx 0

ch_ick= 0

gos 1

acrm 0

assoc_req_ie_len 8h

assoc_rep_ie_len 120

aid 0

band 0

center_freq 24b2

wyiclth [

center_freql 2462

center_freqd 0

=bd] Exiting connecting state

ohd] State Action ###connectingd#d —>>» ##disconnech#s
['F][=h] Entering disconnect state

[AF[SM] Will retry connect after 2 seconds .

[ B]E2mIMFO 10460 [main.c; 67] [AFF] [EVT] disconnect 10460[1E][m

I [+]

EEPEPEPEPEPEPELES.

—

[/F]
[/F]

Lo s N e | e




o If you use your phone as a Wi-Fi hotspot, you will see the core chip’s info:

23100 ao® %l 15%n

< Mobile Hotspot

Connect to this Mobile Hotspot on another device using the
password or @R code,

Band
2,4 GHz

Other bands provide better performance.

Auto Hotspot

ACCOUNT

Connected devices

Bouffalolab_BL602-4¢c11f

31 PM




CONCLUSION

Through this tutorial, you have set up suitable environment on your
computer in order to successfully utilize the Ai-Thinker’s Ai-WB2-12F
module through two example projects: blinking an LED, and connecting to a
Wi-Fi network. Feel free to leave a comment below if you have any questions.



